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Abstract: The 21
st
 century computer education skills refer to the use of computer Microsoft Office skills, 

Internet skills,social networking and media skills, and digital skillsfor teaching, learning, research and 

communication. These skills are important because an increasing number of organizations and institutions of 

learning are moving their services such as interview, admission, registration, payment, teaching and 

communication online thus expecting their consumers, citizens, workers, researchers, administrators and 

students to have sufficient skills to use them to succeed. Students and teachers of the 21
st
 century should use 

these skills for collaboration, communication, creativity, critical thinking, feedback, innovation, presentation, 

problem solving, productivity, reflection, and interactions with students, parents and with their colleagues 

globally. These skills are most relevant, useful, in-demand, and universally applicable skills for students, 

teachers and educational administratorsto competitively succeed in this knowledge-based society. Integrating 

these skills into the curriculum of computer education and teaching students these skills shouldplacethem at the 

competitive advantage ofthis information-age, technology-driven economy and information society.Among 

other challenges facing computer education in Nigeria include:inadequate funding, inadequate ICT resources 

and insufficient computer education skills which make several services unavailable, redundant and 

unproductive. This paper examinesthe computer skills, prospects and challenges inNigeria. The following 

recommendations among others are made for improvement in line with the global best practice of 

makingadequate fundingto education, massive training and retraining of teachers and students, provision of 

internet connectivity and electricity as well as provision of functionalone laptop per child (OLPC). 

 

Keywords: computer education skills, ICT skills, 21
st
 century skills,Microsoft Office skills, students and 

teachers in Nigeria. 

 

I. INTRODUCTION 
In a world increasingly dominated by technology, basic computer literacy is an important professional 

and personal skill required of computer education students and lecturers [1]. [2] defined basic computer skills 

which is a sub-set of Information and communication technology (ICT) as the usage of a computer, 

understanding the basics of computer, managing computer files, word processing, spreadsheets and databases, 

creating presentations, finding information and being aware of the social and ethical implications of Internet use.  

ICTs which stand for Information and Communication Technologies (ICTs) are defined as diverse set 

of technological tools to communicate, create, disseminate, store, utilize and manage information, [2].[2] ICT 

tools include: computers, the Internet, satellite system, broadcasting technologies (radio and television), and 

telephony (cellular phones), and applications associated with them such as videoconferencing and distance 

learning. The types of ICT in education can be broadly categorized as follows:(a) ICT as a subject such as 

computer studies, (b) ICT as a tool to support traditional subjects such as computer-based learning and 

presentation across the curriculum, (c) ICT as an administrative tool for organization of education management 

information systems (EMIS) such as staff and students‟ records, payroll, (d) ICT as a tool in achieving literacy 

for all [3]. The 21
st
 century skills refers to ICT competencies skills for collaboration, enhancing digital literacy, 

critical thinking, and problem-solving in today's competitive world [4]. 

Computer education skillsaccording to [4],[5],[6] are necessary skills for students and teachersfor 

creating, opening, saving and printing documents; inserting data into cells and formatting text and images; using 

data in charts and graphics and working with tables and footnotes, hiding and merging cells and using simple 

functions such as SUM which are imperative to survive in the world of electronic communication.Without 

computer basic skills, nobody can ensure success in teaching and learning[8]&[9]. [1] pointed out that in this 

world of digital competitive teaching job which increasingly demands computer skills, students and teachers 

who learn to use these skills right from an early age are at a marked personal and professional advantage.  

http://www.ajhssr.com/
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II. LITERATURE REVIEW 
This section reviews literature relevant to this topic under the following sub-headings: The 

importance and types of computer education skills,Basic Laptop skills, Windows skills. Keyboard and Mouse 

Skills, Word processing skills, spreadsheet skills, Microsoft PowerPoint Presentation skills, database skills, 

Internet skills, Web browser skills, social media and networking skillsand the challenges facing acquisition of 

computing skills in Nigerian institutions of learning 

 

2.1 Importance and Types of Computer Education Skills  

The importance of computer education skills in enhancing and improving the quality of education has 

made the Federal Government of Nigeria to launch the National Policy on Computer Literacy at primary, 

secondary and tertiary levels of education in 1987 [10]. [10] the objectives of computer education in Nigeria 

areto: (a) equip the individual or students with thorough understanding of the concept of computer to function 

properly in this technology century, (b)use computer education as a new instructional system that was designed 

to improve the quality of teaching and learning, (c) develop a computer literate society in Nigeria, (d) facilitate 

the use of computer as teaching and learning tool in all subject areas and to acquaint students with knowledge of 

computer technology, (e) assist students appreciate the potentials of the computer and itsapplication in various 

aspects of life and occupation, and (f) acquaint teachers and students with ICT knowledge and skills. 

[9] pointed out that computer education introduced in the Universal Basic Education (UBE) 

curriculum in 1987 was a steptowards the development of computer education in Nigeria which is a great 

motivation and booster for the development of computer education career in Nigeria.  To improve students‟ 

performance, [11] opined that students who use computers have been shown to attend school more steadily, felt 

more involved and perform better by getting higher grades on exams than students who do not use computers. 

Using computers get students to become more focused on their work at home. [11] students are generally more 

„on task‟ and express more positive feelings and motivation when they use computers during lessons and even 

outside school hours. 

The utilization of ICT skills in institutions of learning playssignificant roles in 21st century‟s 

classroom as expressed by [9]:(1)The use of ICT enhances the identification of different national and 

international journals and books as well as enhances seamless peer to peer collaboration, peer review and 

sharing of research findings among researchers,and speedypublication and communication of research findings 

globally in respective of distance and geographical location.(2) The use of ICT is tailored to learners‟ need 

thereby enhance individualized learning and improves students‟ performances. (3) Online assessment eliminates 

cheating and gives immediate feedback and faster presentation of students results thereby encourage and 

motivate students continuing learning.(4)ICT has changed the role of teacher in the classroom from that of the 

teacher centre/ font of knowledge/provider of all-knowledge to student-centre where the teacher is an 

instructional manager/a guide or couch helping to guide students through individualized learning pathways, 

identifying relevant learning resources, creating collaborative learning opportunities and providing insight and 

support both during formal or informal classes.(5) ICT improves the process of teaching, learning, research and 

communication allowing teachers to edit, add to, or otherwise customize material for their own purposes, so that 

their students receive a tailored copy that exactly suits the style and pace of the course. (6) The use of ICT 

enhances the training and retraining of pre-service and in-service teachers. (7) ICT enhances teachers‟ 

interactionwith students and parents and provide immediate feedback on students‟ academic performances. (8) 

The use of ICT enhances teachers‟ lesson preparationand presentation during teaching. (9) ICT can provide 

students with individualized learning allowing them to progress at their own pace.  

[9] explained that(10) Virtual learning tends to increased convenience, schedule flexibility, 

knowledge retention, immediate feedback,accessibility and affordability, popular and enhance effective teaching 

and assessment of students anytime, anyplace and anywhere in respective of Covid 19 pandemic where students 

are locked down at home. (11) The use of Internet help teachers to connect and accessinglimited resources on 

the net to equip them in their research and for effective teaching of students.(12) ICT helps in improve the 

effectiveness of teaching skills as well as in innovative the classroom instructions.(13) Mobile Learning with 

internet access and computing capabilities is making smart phones an indispensable tool for learning within 

formal and informal setting. (14) ICT facilitates the improvement of professional development and educational. 

(15) Management of human and material resources as well as enhances active learning of teacher trainees. (16) 

With ubiquitous learning, the emergence of increasingly robust connectivity infrastructure and cheaper 

computers, school systems around the world are developing the ability to provide learning opportunities to 

students “anytime, anywhere. (17) The use of White Interactive Board also called smart board with features of 

multimedia is now replacing the ancient technology thereby making learning interactive, active and motivating. 

(18) ICT facilitates the use of different methods and strategies of teaching for effective learning. (19) ICT 

electronic learning also known as e-learning or online learning is a paperless way of learning has facilitated self-

paced, and personalized content, scalability, consistency and cost effective is best suited for everyone because 

https://www.ebay.com/sch/i.html?_nkw=computers
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the content is accessed, consumed, discussed, and shared at the time that suits the learners. (20) Access to the 

Internet gives students access to a broad range of resources to conduct research in different ways, which in turn 

can increase the engagement, improves knowledge retention, encourages individual learning, collaboration, 

encourage teachers and students to develop skills essential for the 21st century. (21) Different ICT tools such as 

word processing are used to process, edit, save and retrieve data; Database for management of students and staff 

records, Spreadsheet for computing students „resultsand staff records/payroll, and PowerPoint for effective 

presentation of lessons. 

[9]pointed out that (22) various types of ICT web browsers such as Google Chrome, Firefox, 

Microsoft Edge (which replaced Internet Explorer), Opera, Safari, Chromium, and Polyporehelp student-

teachers to brows, download, edit, save and retrieve documents online for their teaching practice. (23) ICT 

prepares teacher for the use of their skills in the real classroom situation and also prepare students for their 

future occupation and social life. (24) ICT is used as an “assisting tool” forassignments, communicating, 

collecting data and documentation, and conducting research. (25) ICT as a medium for teaching and learning 

which appear in different forms, such as drill and practice exercises, in simulations and educational networks is 

used for teaching and learning itself, the medium through which teachers can teach and learners can learn. (26) 

The use of ICT minimizes costs and saving time associated with information delivery and automating regular 

day-to-day classroom tasks. (27) ICT as a tool is used for the improvement in the management,organization 

andadministration of an institutions as well as enhance the quality and efficiency of service delivery. (28) 

Teachers must be skillful in the use of ICT presentation to support students learning using motion picture, 

animation, simulation training which in turn equip students to be skillful too. (29) ICT enhances learning 

experiences and providing new sets of skills as well as reaching more students with Massive Open Online 

Courses(MOOCs) through distance learning. (30) The effective application of ICT removes the traditional 

method of teaching and prepare teacher to apply modern method of teaching. (31) ICT plays an important role in 

evaluation and assessment of student progress. (32) Online digital too is a repository for lectures that enhances 

access to course materials for both students and lecturers. (33) ICT is store house of educational institution 

because all educational information can safely be stored through ICT.(34) Cloud computing is a 

network/serverthat offers more collaboration, easy accessibility to latest learning materials, real-time, 

stability,security,share ability,tractability and mobility.Cloud computing also enhance transfer of stored files 

across multiple sources using virtualization to store and retrieve resources data without losing important 

information. It also eliminate the need for expensive and outdated textbooks, cost of expensive hardware such as 

copier, file cabinets, costsofpapers, less power in computing memory, reducing the need for technical 

expertise.(35) ICT bridges the gap between teacher and students helping teachers to pass information to students 

within a very short time thereby helping teacher to communicate properly with their students. (36) ICT helps 

teachers to design and develop educational policy, curriculum and educational environment easily and faster. 

(37) ICT helps teachers to easily identify, monitor and assess the creative and slow learners in educational 

institution(38) The use of ICT helps teachersto increase their personal knowledge, attitudeand skills. (39) ICT 

helps teachersto collaborate, share ideas and learn most from their own networks as well as learning from others. 

 

The 21
st
 Century Computer Education skills required by students and instructors to succeed 

 
Source: Researchers’ design model, 2020 
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The computer education skillsas indicated in Figure 1 above are sets of skills that students and 

teachers need to develop in order to succeed in the information age. There is a broad agreement that tomorrow‟s 

students and teachers need different computing skillsfor writing, critical thinking, self-initiative, group 

collaboration, and technological literacy to succeed in higher education, modern workplaces, and adult 

life[2].[2] pointed out that making ICT resources available to schools would enable students and teachers learn 

how to: (a) find and select information from digital and online sources, making judgments about accuracy and 

reliability, (b) create, manipulate and process information using technology to capture and organize data, in 

other to investigate patterns and trends; explore options using models and simulations; and combine still and 

moving images, sounds and text to create multimedia products, (c)collaborate, communicate and share 

information using connectivity to work with, and present to, people and audiences within and beyond the 

school,(d) refine and improve their work, making full use of the nature and pliability of digital information to 

explore options and improve outcomes. 

[2] further explained that the 21
st
 century learning means that students need various ICT skills to 

master content while producing, synthesizing, and evaluating information from a wide variety of sources with an 

understanding of and respect for diverse cultures. Student teachers can use virtual tools and open-source 

software to create borderless learning territories for their students of all ages, anytime and anywhere during 

teaching practice [9].  

For effective teaching of students to be successful in this 21st century knowledge-based economy, 

teachers require different ICT skill for teaching[12]. Collins and Halversonlamented that, many teachers do not 

yet possess the skills necessary to be successful in facilitating the 21
st
century learner because they lack exposure 

to ICT training. Teachers not only need to understand how to use ICT in their teaching, but also understand how 

to help their students to use ICT for their own learning. [12] suggested that teachers need to provide students 

with the basiccomputer and laptop skills to learn both within and outside the classroom. 

 

2.2 Basic Laptop skills 

Laptop skills are skills [6],[7] students and teachers can use to perform the following functions: 

(a)Identify the features of laptop such as clipboard, cut, copy, paste, delete and insert,(b)start up a computer and 

related equipment such as printer and scanner, (b) create a document, (c) edit the text and document, (d)format 

text, such as font type, bold, underlined and italicized documents, (e) print the document, (f) save the document, 

(g) manipulate text such as copy, paste, move and delete text within a document, (h) insert elements from other 

software, such as illustrations and photographs, (i) easily check and correct mistakes using spelling and 

grammar checker to improve the quality of your work, (j) save your work so as to come back to it at a later time, 

(k) format documents using available features such as borders, text layout, (l) import data from a database and 

use it to create mail merge, (m) shut down and restore the computer and use standby generator and UPS, (n) 

installing and uninstalling software, (o)customize desktop, resolution and wallpaper, (p)set time of the day and 

the time zone, (q)create and insert page numbers using either header or footer,(r) use bulleting and number 

features, (s) add clip art and other graphic images to the document. 

 

2.3 Windows Skills 

The term Windows is seenasa separate viewing area on a computer display screen which enabledigital 

students and teachers use a virtual and to voice assistant like Cortana, Alexa,HeySiri and Google assistants on a 

daily basis to create, copy, move, and rename files and folders, zipping and extracting files, launching and 

closing applications, updating windows, [13], [14].It is important for students and teachers to utilize the ICT 

skills to enable them share files over home networks and connect to the internet. [13] maintainedthat Windows 

skills are skills that students and teachers can manipulate in order to perform the following functions:(a) Open 

an application, (b) minimize windows, (c) maximize windows, (d) restore windows, (e)close windows,(f) move 

window,(g) resize window, (h) stroll window up and down, (i) configuration management, (j) use Microsoft 

Windows server, (k) browsing with Microsoft edge, (l) use security and networking, (m) supporting and 

troubleshooting,(n) operate Microsoft PowerShell, (o) Microsoft patch management, (p)backup and recovery 

techniques, (q)Microsoft Office 365. 

 

2.4    Keyboard and Mouse Skills  

[15] opined thatcomputer keyboard and mouse are input devices used to enter characters and 

functions into the computer system. [16],[15]pointed out that akeyboard typically contains keys for individual 

letters, numbers and special characters, as well as keys for specific functions. Typical keys are classified as 

alphanumeric, punctuation and special keys. [16],[14] mastering the keyboard skills is one of the most important 

competencies required of students and teachers in order to function effectively and efficiently in this 21
st
 century 

information age using: (a) Function keys such as F1-F12, (b) Numeric keys, (c) Escape keys, (d) Caps lock and 

https://www.quickstart.com/find-training/technology/microsoft/applications/ms-office-365.html
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number lock, (e) Window keys, (f) Combine keys with shift, control, alter and FN, (g) Cardinal/movement keys 

such as those arrow keys pointing up, down, left and right. 

Today everyone uses a computer and whether you are using mobile or tablet device, desktop or 

laptop, you will expect to send emails, write reports, complete online tasks and to be self-supporting in 

secretarial skills that makes you look professional[9].[15] explainedthat Touch typing using keyboard makes 

you perform your tasks faster with less time and become more productive. This also means spending less time 

sitting at a computer. Automatizing the process improves the quality of your writing as well. Mastering 

keyboarding improves accuracy and can help with decoding and sight-reading skills for children and adults who 

struggle with specific learning difficulties[16]. The use of keyboard skills can improve your career prospects 

and pave way for success in further education. [16] stressed that keyboard skills will also benefits the following 

persons with visual impairments, dyspraxia(problem with reading), dysgraphia (problem with writing) and 

other specific learning difficulties who often struggle when it comes to writing by hand. Learning how to type 

can help these categories of students to achieve their full potential at school by reinforcing their literacy skills. 

Similarly, a computer mouse is another important input tool for communication with computers. It 

lets users point to objects on the screen, click on them and move them. There are two main mouse types namely: 

optical and mechanical. The optical mouse uses an electronic eye to detect movement [17].[17explained that 

the mechanical mouse uses a rolling ball to detect movement and requires regular cleaning to work properly. 

[17] pointed out that there are other devices that can do the same thing as a mouse commonly known as 

Trackball: A trackball has a ball that can rotate freely. Instead of moving the device like a mouse, you can roll 

the ball with your thumb to move the pointer.Touchpad also called a trackpads a touch-sensitive pad that lets 

you control the pointer by making a drawing motion with your finger. Touchpads are common on laptop 

computers. Students and teachers can manipulate the mouse to perform the following tasks: (a)hold the mouse 

appropriately, (b) double-click the mouse, (c) single click the mouse, (d) right click the mouse,(e) left click the 

mouse, (f) click and drag the mouse, (g) customize mouse or touch pad features[17],[15]. 

 

2.5 Word Processing Skills.  

[18],[19],[6] share the same idea that all students and teachers should use Word processing skills for 

the following purposes:(1) Creating, naming, and saving a document showing the difference between “Save” 

(which will save your document under the current name) and “Save As” (which allows you to rename a 

document).(2) Formatting documents using bold, italics, font sizes and aligning text. (3)Creating lists (bullet vs. 

numbered) and their differences which could be used for an outline or brainstorming. (3)line spacing can be 

either one line, 1.5 or double spaced pending on the requirement of an institution.(5) Creating columns which 

are useful for writing articles, pamphlets or other specialized pieces. From the “Formatting” drop-down menu 

students can choose two or three columns, or customize their own number.(6) From the Insert menu, you can 

place and name a bookmark so you can remember to come back to that part later, (7) From the Insert menu, you 

can insert an image so that you can upload it.(8) Students can hyperlink a document by highlighting the text they 

want to hyperlink by clicking and choosing hyperlink and then paste the URL of their destination, (9) Using 

Find and Replace, students can use the Edit menu to find all of the incorrect spelling and ask Word to 

automatically replace them with the correct spelling, (10) using Grammar and spell check facility to check the 

spelling and grammar of your work by right click to find the suggested correction,(11) Inserting a page break 

using the insert menu either at the top of a new page. (12) Using Word Count which appear as a running total at 

the bottom of the screen in Microsoft Word are usually required of students who will need to write within a 

minimum and maximum word count range. 

Other Word processing skills [18], [19],[6]include:(13) Inserting Tables/Rows/Columns which allow 

students to insert a table in their writing by clicking the table button on the toolbar and choose to add or select 

how many rows and columns they may need. (14). Cell shading can be done by highlighting the cells you want 

to shade. (15) Changing column/row width by dragging the gridlines between rows and columns to suit your 

needs. (16) Text alignment in tables can be done by right clicking in the cell to choose how you want your text 

to be displayed. (17) Changing text direction can be done by clicking within a designated cell and from the 

“Layout” tab click the text direction button to toggle between horizontal and vertical text.(18) Merging cells can 

be done by highlighting the cells and right click to select Merge. (19) Inserting a header and footer such as 

name, logo, a title or a page number which can appear on every page as desired. This can be done by choosing 

either header or footer from insert menu to add text or double click at the very top or bottom of a page to insert 

your header or footer as the case may be. (20) Footnotes allow an author to make a note about an idea in the 

text, (21) Footnotes is common in academic which allow an author to make a note about an idea in the text 

which can be done by clicking on footnote from the insert menu to add your comment. (22) Page numbers are 

important in research papers and longer pieces of writing to help readers reference points in the text. From the 

insert menu, choose page number and select where on the page you would like the numbers to show. (23) 

Inserting the date is very important when you want to include the date and time on written work. Put your cursor 

https://www.readandspell.com/visual-impairment-in-the-classroom
https://www.readandspell.com/dyspraxia-vs-adhd
https://www.readandspell.com/strategies-for-dysgraphia
https://www.readandspell.com/what-are-learning-difficulties
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on your document where you will like the date to go and select Date and Time from the insert menu. (24) 

Printing your document can be done by either selecting the printer icon on the toolbar or click Print from the 

File dropdown or use the shortcut key from the keyboard by typing CTRL + P and decide on how many copies, 

whether on double sided or single then the type of printer and click okay. (25) Page Orientation is very 

important when you want to print your work. In most written work portrait (your paper goes up and down), and 

also check the space from left to right and then select page setup from the File dropdown menu and choose 

Landscape. (26) Custom margins is very important when you want to add a block quote or leaving room for 

annotations. You would want to change the margins for all or part of your text. This can be done by either using 

the formatting tab or using the ruler at the top of your page, then highlight the text you want your new margins 

to apply to before you get started. 

 

2.6 Spreadsheet skills 

Spreadsheet is one of the statistical tools. [20] pointed out that spreadsheets especially Microsoft 

Excel are used for keeping students‟ records, creating graphs/charts, keeping track of anything, financial record 

keeping, adding/average numbers, sorting out things, and login/registration and password of documents and 

organize and calculate information in column and rows. [5],[6] opined that using spreadsheet applications is 

becoming increasingly important for employment opportunities. [20],[6] explained that students and teachers 

should be able to demonstrate the following Excelskills: (a) open Microsoft Excel and be conversant with its 

environment, (b) interpret and communicate information in an existing spreadsheet, (c) enter data in an existing 

spreadsheet: enter text and numeric entries in cells, use the entry bar, (d)print a spreadsheet by printing only 

selected part, (e)manipulate data within an existing spreadsheet in order to solve an existing problem, (f) create a 

spreadsheet with rows, column and headings, (g) create the three basic types of cells such as label, value and 

formula, (h) create and copy formula and functions to perform calculations, (i) insert Excel into word document, 

(j) use AutoSum, (k) utilize functions, (l)use conditional statement (What If/ Nested statement to perform 

multiple problems. 

 

2.7 Microsoft PowerPoint Presentation skills.  

Microsoft PowerPoint is a presentation creator. It is a great way to organize presentations that you 

will be displaying to people, as it organizes information clearly and with noticeable organization[21]. [21] 

opined that each slide should feature different information, and combined with the structural movements of the 

slideshow, create a coherent presentation. [22],[21] pointed out the following PowerPoint presentation for the 

following varieties of purposes: (a) prepared to win by delivering the right message to your audience effectively, 

(b) designed correctly with illustration and visually stand out, (c) practiced to perfection, (d) delivered with 

poise that is communicating with confident with outward projection, and (e) providing information, (f) teaching 

a skill, (g) reporting progress, (h) selling a product or service, (i) making a decision, (j) solving a problem. 

[23], [24],[21] pointed out the following as tips for making effective PowerPoint presentations: (1) 

Open Microsoft PowerPoint by clicking "File" at the top left of your screen and click "New Presentation if a 

page with templates doesn't automatically open. (2)To use a template, either click the "Design" tab or go to 

"File" again and click "New from Template".(3)Insert a new slide by clicking on the "Home" tab and then the 

"New Slide" button. (4) Save your presentation by clicking "File" and "Save", making sure to specify which 

folder or destination you want your PowerPoint to be. (5)Know your stuff. (6)Write it out. (7) Highlight what‟s 

most important. (8) Know your audience. (9) Rehearse your work. (10) Rewrite after you rehearse. (11) Share 

with a friend. (12) Keep your slides simple. (13) Limit words on your slides. (14) Use high-quality photos and 

graphics. (15) Use accurate and relevant charts and graphs. (16) Use high-quality, fresh templates. (17) Choose 

appropriate fonts. (18) Choose color well. (19) Clean + simple formatting makes all the difference. (20) Make 

sure all objects are aligned. (21) Limit punctuation and avoid putting words in all capital letters. (22) Avoid 

over-formatting your points. (23) Combine information with graphics in PowerPoint. (24) Practice with a timer. 

(25) Slow it down. (26) Pause more often. (27) Record yourself., (28) Choose three focal points in the room. 

(29) Vary your sentence length. (30)  Practice in front of a mirror how to present your work (31) Use “present 

mode” when rehearsing. (32) Engage the audience by asking questions. (33) Take a deep breath. (34) Lighten up 

your mood. (35) Remind yourself to take it slow. (36) Stop with the sound effects. (37)Do notuse flashy slide 

transitions. 

[23], [24], [21] explained further tips for making effective PowerPoint Presentations toinclude: (38) 

Beware of clip art. (39) Read directly from your paper and notecards. (40) Read directly from your PowerPoint 

presentation. (41) Use the visual guides. (42) Use a few animations. (43) Add a video to your PowerPoint. (44) 

Add charts and graphs. (45) Build your own infographics with SmartArt. (46) Use presenter view. (45) Track 

your PowerPoint changes. (46) Use simple design template with contrasting colors and font for text and 

background with light text on a dark background is the best. (47) Simplify and limit the number of words on 

each screen.(48) Avoid the use of flashy transitions such as text fly-ins. (49) Use good quality images that 
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reinforce and complement your message. (50) Limit the number of slides with a good rule of thumb is one slide 

per minute. (51) Learn to navigate your presentation in a non-linear fashion. (52) Know how to and practice 

moving forward AND backward within your presentation. (53) View your slides on the screen to make sure 

slides are readable from the back row seats. (54) Have a Plan B in the event of technical difficulties. (55)Do not 

read from your slides, hence the content of your slides is for the audience, not for the presenter. (56) When 

possible, run your presentation from the hard disk rather than a CD disk to avoid slowing your presentation. 

 

2.8 Database Skills 

A database(DB) is an electronic filing system for collection of information that is organized so that it 

can easily be accessed, managed, and updated[25].[26] opined that there are three common job titles in the 

database area, which are Database Administrator (DBA), Database Programmer, and Database Architect which 

are: (a) The basics of tables, columns, rows, (b) SQL Select, (c) Writing Data, (d) commands to create, modify 

and drop tables, or Data Definition Language (DDL), (e) knowing how to use a Query Analyzer or optimization 

tool, (f) understanding normalization, (g) understanding Denormalization, (h) understanding Primary keys, 

foreign keys and constraints, (i) understanding transactions, (j) understanding ACID, (k) understanding Indexes 

as optimization tool, (l) views, (m) database security, (n) upgrades and installs, (o) efficient access of database 

from application, (p) bulk operations: loading or exporting large amounts of data, (q) understanding of contexts 

and how they lead to different sets of best practices, (r) preventing performance degradation through various 

maintenance tasks, (s) deployment strategies: partitioning, tablespaces, (t) deployment strategies, failure 

protection from simple backup to hot standbys, (u) server side coding: stored procedures and functions, (v) 

server side coding: triggers, (w) temporary tables. 

[25], [26]opined that education students and teachers can use the list of database skills required to 

become a successful database administrators to:(a) Open a database document, (b) use information from an 

existing database, (c) enter data, add a record, and delete a record from an existing data, (d) sort a database by 

specific fields, search for desired information given 1 category and given 2 criteria by using “and”, “or”, “not” 

connectors, (e) insert database fields into word processing document, (f) create an efficient physical database 

design from a logical data model and application specifications, (g)collect, store, manage, the database, (h) 

translate a data model,(i) implement robust backup and recovery procedures as a policy of DBA, (j) design 

databases so that only accurate and appropriate data is entered and maintained to ensure data integrity, (k) deal 

with performance problem which is a nightmare faced by DBAs, (l) ensure availability of data 24x7. (m) ensure 

data security, (n) ensure more connections and more users, (o) ensure general database management in the 

organization, (p) ensure full connectivity of databases to avoid interruption of educational system. 

 

2.9 Internet skills.  

The Internetis the global system of interconnected computer networks that use the Internet protocol 

suite (TCP/IP) to link and communicate with billions of devices worldwide[27]. Students and teachers [4], 

[27],[18], [6]can navigate the Internet and perform the following functions: (a) launch your browsers such as 

Internet, Firefox, Mozilla, Google Chrome, (b) enter a web address/URL, (c) use back and forward buttons, 

(d)differentiate between the mouse pointer function of the hand with a pointing finger or an arrow, (e)searching 

your website, (f) refreshing and stop, (g) setting the Home Page, (h) remember your usernames and passwords, 

(i) identify the location of a hyperlinks on status bar, (j) use the search box, (k) configure pop-up settings, (l) use 

the favourite features, (m) use the history list, (n) open multiple web pages, (o) differentiate between different 

dot.com of different countries, (p) differentiate between names of different hosting webs. 

Similarly, using E-mail also known as Electronic Mail is the information stored on a computer for 

transmission of messages over communications networks that is exchanged between two users over 

telecommunications[27]. [27]opined thate-mail is a message that may contain text, files, images, or other 

attachments sent through a network to a specified individual or group of individuals enable you to: (a) use your 

username and password, (b) use webmail, (c) use client e-mail program, (d) use BCC for multiple clients. 

 

2.10 Web browser skills.  

[4],[6]defined the term, “web browser “which is commonly referred to as a browser asa software 

application for retrieving, presenting, and traversing information resources on the World Wide Web (WWW). 

An information resource is identified by a Uniform Resource Identifier (URI/URL) and may be a web page, 

image, video or other piece of content.A web browser, or simply "browser," is an application used to access and 

view websites which include Microsoft Edge, Google Chrome, Mozilla Firefox, Apple Safari, and Opera.[27] 

opined that students and teachers can use the web browser to perform the following functions: (a) Access and 

use resources on the internet and World Wide Web using Web browser, (b) use web browser to access specific 

website and to perform specific web search, (c) know the URL of the college and the department; be able to find 

information on these sites, (d) use a web browser to perform a keyword search for specific information, (e) 

http://searchsqlserver.techtarget.com/definition/information
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create, delete, organize, use, and save favorite/bookmarks, (f) change the web page you will use as the home 

page in your browser, (g) download information from the World Wide Web, (h) coy or save images from a web 

page, (i) save a web page, (j) comply with copyright and educational fair use of policies for using any images or 

content you save, (k) evaluate and assess downloaded documents. 

 

2.11 Social Media and Networking skills.  

Social media are computer-mediated tools that allow people to create, share, or exchange information, 

career interests, ideas, and pictures/videos in virtual communities and networks[28], [29].The advantages of 

social media and networking are: easy and practical way to quickly communicate, reach people fast, connect 

with people all across the world and widen educational contacts. 

On the other hand, social networking skills involves building and maintaining contacts and 

relationships with other people.Social networking is the development of social and professional contacts; the 

sharing of information and services among people with a common interest[4].Researchers [30], [28], [29],[4], 

[31], [32],[9]share the same opinions that the 21
st
 students and teachers can use the following social networking 

websites to promote academic and social events: (a) Social networking sites such as Facebook(founded in 2004 

by Mark Zuckerberg, Eduardo Saverin, Dustin Moskovitz, and Chris Hughes) and MySpace, (founded in 2003 

by Thomas Andersonto with Chris DeWolfe) for the purpose of socialization with friends, classmates, or other 

people, (b)Forums website that allows visitors to interact with each other with their opinions, advice, and help. 

(c) Microblogging is a cousin of texting, allowing students to express their thoughts, feelings, and events 

immediately, (d)Facebook is a popular free social networking website that allows registered users to create 

profiles, upload photos and video, send messages and keep in touch with friends, family and colleagues, 

(e)Twitter (founder in 2006 by Jack Dorsey, Noah Glass, Biz Stone, and Evan Williams) is a free microblogging 

service that allows registered members to broadcast short posts called tweets,(f)Google+ is a social 

network(founded in 2011 by Vic Gundotra was designed to compete with Facebook, and has extensively 

integrated the service across search, Gmail, YouTubeand chat though he later resigned)is designed to replicate 

the way people interact offline more closely than is the case in other social networking services, (g)Wikipedia 

(founded in 2001 by Jimmy Wales and  Larry Sanger) is a free, open content online encyclopedia created 

through the collaborative effort of a community of users known as Wikipedians, (h)LinkedIn a subsidiary of 

Microsoft(founded in 2002 by Reid Hoffman) is abusiness-oriented social networking Web site designed 

specifically for the business community registered members to establish and document networks of people they 

know and trust professionally, (i)Reddit(founded in 2005 by Alexis Kerry Ohanian) is a social news website and 

forum where stories are socially curated and promoted by site members, (j) Pinterest(founded in 2009 by Ben 

Silbermann, Paul Sciarra, and Evan Sharp) is an American image sharing and social media service designed to 

enable saving and discovery of information on the World Wide Web using images and, on a smaller scale, GIFs 

and videos, in the form of pin boardsvisually accessible by clicking the site (k) Instagram (founded in 2010 

byKevinSystrom and Mike Krieger) is a video and photo sharing social networking service owned by 

Facebook. (l) YouTube a Google's subsidiaries (Founded in 2005 by three former PayPal employees namely 

Chad Hurley, Steve Chen, and Jawed Karim)is an American online video-sharing platform which become the 

most popular free video-sharing platform in the world where teachers and students can use in the class to share 

and interact. 

 

III. Challenges Facing Acquisition of ComputingSkills in Nigerian Institutions of learning 

[33],[9]share the same opinions and pointed out the following as challengesfacing computer 

education in Nigeria:(a) Poor implementation and management strategy which impedes the success of computer 

education in Universal Basic Education (UBE) towards achieving its objectives, (b) inadequate computer 

laboratory, (c) inadequate qualified computer science teachersto impart computer education knowledge to their 

students, (d) lack and insufficient supply of electricity, (e) high cost of acquisition of computers of which many 

individuals and educational institution cannot afford to purchase and maintainthem, (f) lack of motivation, poor 

remunerations and incentives to computer science teachers greatly impedes on the development of computer 

education, (g) lack of computer library online in educational institution to facilitate access to reading 

materials,(h) inadequate furniture‟s in educational institutions such as sitting and writing furniture impedes on 

the development of computer education in schools, (i) lack of internet or slow connectivity to access resources 

online impedes the progress and development of computer education in Nigeria, (j) broken down computers are 

dumped as e-waste management, (k) fear by the administrationthat their students will be exposed to undesired 

Internet sites (pornography)that have exacerbated many kinds of aggression against women marketing and 

depicting their images as a sexual object, fear of viruses leading to data loss.While this may be true to some 

extent, proper education on the safe use of computers can help alleviate some of this fears, (k) fear by the 

teacherswho are not ICT literatebeing rendered irrelevant by the introduction of computers in his/her class, (l) 

obsolete computersrunning on win98 or win 95not compatible with current hardware and software thereby 
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lowering the morale of both the teachers and the students, (m) increased moral degradation as a result of internet 

pornography, cyber bullying and other anti-social behaviors is a worrying emerging problem to the progress and 

development of computer education. 

 

IV. RECOMMENDATIONS 
The following suggestions and recommendations are necessary for the progress and development of computer 

education in Nigeria: 

a. Computer Educators Association of Nigeria (CEAN) in consultation with the Federal Ministry of Education 

should regulate, monitor and evaluate the wide disparity between policy pronouncements and policy 

implementation in Nigeria institutions of learning. 

b. The provision of 26% funding for revitalization of computer education in Nigeria from the Federal 

Government should be our priority. 

c. There should be an enforced policy on massive training and retraining of teachers from primary to tertiary 

institutions of learning to dispel the fear that they will be replaced by computers.  

d. For effective and efficient learningone laptop per child (OLPC) should be provided for their learning right 

from primary to tertiary institutions in Nigeria  

e. Government should put more effort in developing and reviewing computer education curricular in primary 

and secondary schools on regular basis to be in line with global best practices. 

f. Computer Education courses should be made compulsory in all levels of education right from primary to 

higher level of education in Nigeria. 

g. Computer education laboratories should be established throughout all institutions of for proper take up of the 

UBE programmes in the country 

h. Government should make sure there is regular supply of electricity to all levels of education for meaningful 

teaching and learning is maintained 
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